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PROCEDURES AND GUIDELINES FOR THE CONDUCT OF THE FINAL PRACTICAL
EXAMINATIONS IN COMPUTER APPLICATIONS TECHNOLOGY AND INFORMATION

TECHNOLOGY - NATIONAL SENIOR CERTIFICATE EXAMINATION: NOVEMBER 2024

1.

The procedures that must be adhered to during the conduct of the final practical examinations for
Computer Applications Technology (CAT) and Information Technology (IT), are brought to the
attention of all concerned.

Teachers and schools must ensure that they have the necessary hardware resources required
to offer Computer Applications Technology (refer to Curriculum and Assessment Policy Statement

(CAPS), no 2.4 in particular).

Teachers and schools must verify that the software tools they use to implement CAT and/or IT,
comply with all the content and skills as listed in the Curriculum and Assessment Policy Statement
(CAPS) and latest Examination Guidelines for CAT and IT. Examination papers will NOT cater for
or be adapted to provide for tools that do not comply with the CAPS or Examination Guidelines.
(Also refer to point numbers 6 and 7 in this circular).

Districts are also kindly requested to support schools offering CAT and IT to acquire
software licenses where applicable, as these are viewed as core Learning and Teaching

Support Material (LTSM) for CAT and IT.
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7.

Prior to the examination districts must:

Ensure that all schools offering CAT and IT have been audited and are ready to conduct the
practical examinations. Where schools do not have the resources to conduct the examination,
districts must ensure that adequate arrangements have been made for candidates to write at
an alternative venue.

Have plans in place to provide data files and organise computer laboratories in preparation for
the examinations.

Ensure that they have received data files from Provincial Examination Directorate, in all the
formats compatible to the programs used by all their schools.

The Grade 12 NSC Oct/November 2024 Computer Applications Technology (CAT) examination
makes provision for the following software packages:

The latest three versions of Microsoft Office will be allowed for examination purposes. For
2024 this will be, MS Office 2021 (also known as MS Office 365), MS Office 2019 and MS
Office 2016.

Notepad ++ or Notepad and a web browser (example intemet explorer or Microsoft edge) for
the development of web pages. NOTE: No internet access is required or allowed during
the practical computer examination.

The November 2024 Computer Applications Technology examination will provide the learner
data folder as a password-protected executable file. Once leamers have successfully extracted
the data files, the learners will then have access to all the data files in the data folder.
. Learners will be required to extract the data folder using the password provided in the
question paper as part of the instructions.
. The process of extracting the data files should take place after learners are seated and
before the start of reading time.
B Learners need to open at least one of the files to view the file content and then close
the file without any modifications (Invigilators must be vigilant during this process).
. After a learner has verified and is satisfied that the data was successfully extracted,
the learner must close the question paper and wait for the reading time to commence.
. Should a learner be unsuccessful in extracting the data, the CAT/IT
teacher/technician must assist the learner with the extraction.
. Ensure that learners rename the data folder with their examination number.

The November 2024 Information Technology examinations provide learner files which are
compulsory to use by candidates when they do their practical examination. The learner files
were prepared and are to be used by candidates with the following software packages:

Delphi 2010 (OR a later version of Delphi that is compatible with Delphi 2010)
MS Access 2010 and upwards.

Districts must ensure that all schools offering CAT and IT have been audited a month prior to
the examinations. The checklist for this process (Annexure A) is attached. All Districts must
have the audit completed and reports available on the 7 October .Districts must consolidate the
audit reports to determine the readiness of all centres offering CAT and IT to write the 2024

NSC examination.
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10.

12.

13

Prior to the practical examination the CAT/IT educator must refer to ANNEXURE A and ensure that.

» the regional settings are set to South Africa.

« the date and time settings, number settings and currency settings are set correctly (Refer to
Annexure A no16).

« the language is set to English (South Africa), the paper size is set to A4 Portrait and e units
of measurement is set to centimetres in the word processing application; the Developer tab is
activated in the word processor application;

« the Autosave option is set to 5-minute intervals;

« no communication can take place between candidates on the network/computers;

 all previous files/folders/documents are removed or isolated;

» the web browser displays images;

+ the required software for IT (Delphi 2010) is properly installed and tested;

+ the required software for CAT is properly installed and tested (MS office 2021 (also known as
MS office 365), or MS Office 2019 and MS office 2016, Notepad ++ or Notepad).

During the practical examination the Chief Invigilator must ensure that:

+ In addition to the invigilator, an experienced CAT or IT teacher is present during all practical
sessions, so that he or she can provide assistance ONLY in the event of a technical
malfunction.

« Allinvigilation requirements are strictly adhered to.

«  All security processes are carried out under the supervision of the invigilator.

 Internet network connections and internet connectivity is disabled.

+ The correct procedures are followed in the case of a power failure or a computer malfunction

After the practical examination is completed, the invigilator must ensure that:

« Candidates check whether all their files are stored within their examination folders and labelled
with their correct examination numbers.

« Candidates complete the Information Sheet (centre number, examination number, application
package used, e.g. MS Office version, e.g. Office 2019, web browser used, e.g. Internet
Explorer and the file names to be marked for each question are completed) and ensure that
the information matches their examination folders.

« The teacher retrieves all candidates’ folders via the network or uses a flash disk to copy all
folders to one central computer or server and checks that every candidate’s file in the folder
corresponds with the information on the Information Sheet.

« The teacher writes all the candidate’s folders to compact disks (CD) or digital versatile disks
(DVD) to be submitted for marking. Two back-up disks (CDs/DVDs) must be written at the
same time, one of which must be safely stored at the examination centre and the other
submitted together with the original to the examination section of the district. This must be
done under the supervision of the invigilator.

« No candidate leaves the examination room until all administrative processes regarding the
conduct of the practical examinations have been completed.

The CAT/IT teacher must check the following with regards to the folders saved onto the CD/DVD.

« The name/label of each candidate’s folder must be the full name of the candidate.
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14.

15.

16.

17.

18.

19.

20.
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the cover/information sheet.
« The examination numbers of candidates appear in a sorted numeric order on the CD/DVD.

« The files in the folders for every candidate leamer must be tested at another computer other
than the computer used for the copying process. This test is to ensure that the files open

successfully.

Should candidates’ folders or files be missing, the Chief invigilator should try to recover the missing
or damaged folders or files before the CD/DVD is written and submitted to the district officials.

The number of candidates’ folders stored/copied to each CD/DVD must correlate with the number
of candidates listed on the mark sheet(s) received. For example, if there are 40 candidates listed
on a mark sheet, the accompanying CD/DVD must have the folders for all 40 candidates in the
same order. If more than one CD/DVD has been used, then all the CDs/DVDs must be packed

together with the relevant mark sheet(s)

IT candidates must check that the code of all units have been printed and then place their printouts
in the correct order before handing in to the invigilator. Ensure that all pages contain their

examination numbers.

The CAT/IT teacher, together with the invigilators, should complete and sign the checklist provided
by the provincial examination directorate. A sample of the checklist is attached (ANNEXURE C).

Candidates’ files may not be saved on flash disks as the potential of having entire files deleted due
to viruses is greater with flash disks. Districts are requested to ensure that schools have access
to CD/DVD writers and the CAT/IT teacher knows how to write data to a CD/DVD before the

examinations.

A full report on any technical problems or irregularities that might have occurred during the
examinations must be submitted to the provincial head office (e.g. missing/damaged files, time lost
due to load shedding/power outages/faulty equipment, deviation from instructions, etc.).

The following timeframes are suggested for ONLY one and two examination sittings respectively:

ONE SITTING: COMPUTER APPLICATION TECHNOLOGY PAPER 1

TIME ALLOCATED DURATION
Seated in computer Iaboratory _ ~ 08:30 il
Reading time 10 minutes _ 08:50-09:00 "
Paper 1 (Practical) 3hours | ~ 09:00-12:00 |
Print (if applicable) and finalise answers, collect | 120 minutes  (will 12:00-14:00
folders, write CDs/DVDs depend on number of

candidates)
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ONE SITTING: INFORMATION TECHNOLOGY PAPER 1

| TIME ALLOCATED SECOND SITTING
Seated in computer laboratory - ___ - 13:30 i
| Reading time 10 minutes 13:50-14:00
Paper 1 (Practical) 3 hours 14:00 — 17:00
Print (if applicable) and finalise answers, 120 minutes (will ]
collect folders, write depend on numbers 17:00 — 19:00
| CD/DVDs, clean computers etc. of candidates)
TWO SITTINGS DURATION
| TIME ALLOCATED | FIRST SECOND SITTING
- SITTING o |
Seated in computer laboratory
07:30 13:00
' Reading time 10 minutes 07:50-08:00 13:20-13:30
' Paper 1 (Practical) | 3 hours 08:00-11:00 13:30-16:30 |
Print (if applicabfe) and finalise 120 minutes (will 11:00-13:00 | 16:30-18:30
answers, collect folders, write depend on the
CD/DVDs, clean computers etc. number of
| candidates) |

21.  Candidates may not leave the examination venue until all printing has been completed (applicable
to IT) and all candidates’ folders and files have been submitted and written to CD/DVDs.

22.  Candidates sitting for the second session must report an hour before the end of the first sitting to
be accompanied to the computer room before the start of the second sitting. This will be done after
all the candidates from the first sitting have left the computer room.

23. If there are any queries regarding the procedures for the conduct of practical examinations, these
should be directed to the directorate responsible for examinations in the province.

24.  The application of the prescribed protocols serves as guidelines for the final examination and every
effort must be made to comply with it.

25 Your co-#Peration in ensuring successful examinations in these subjects is greatly appreciated.

01/10/2024

MR R. TYW. DI DATE

DDG: CURRJCULUM MANAGEMENT AND DELIVERY
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hedsl EASTERN CAPE

EDUCATION

ANNEXURE A
CERTIFICATION (State of Examination Readiness)

PROCEDURES AND GUIDELINES FOR THE CONDUCT OF THE FINAL PRACTICAL
EXAMINATIONS IN COMPUTER APPLICATIONS TECHNOLOGY AND INFORMATION
TECHNOLOGY — NATIONAL SENIOR CERTIFICATE: NOVEMBER 2024

'To be completed by the centres and at least one month before the examination.

Sentres must ensure that all items on this checklist are revisited and are in place TWO days
before the examination)

School name Tel.
No

| District Fax
No.

EMIS No. Cell
No.

Examination centre No.

E-mail address

Name of chief invigilator Cel
No.
Name of IT teacher (s) 1 2
Name of CAT teacher (s) 1 2
! T
Name of IT technician who will Cell
be on standby during the No

examination

1 How many Grade 12 learners will be writing CAT in 20247

2 How many Grade 12 learners will be writing IT in 20247
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3 How many operational computers are available for one examination
sitting? '

4 How many Grade 12 CAT class units does your school have?

5 How many Grade 12 IT class units does your school have?

6 How many computer centres at your school will be used for the
practical examination?

7 How many examination sittings will be required, one or two?
If two, have you applied for a second session?

8 Will your centre be writing at a venue other than your own
examination centre?
If so, please state the venue

9 What plans are in place in case of a power failure?

10 | Is the computer centre networked?

11 If the centre is networked, what type of network environment is
installed? E.g. peer-to-peer; clientserver.

12 | Which operating system is used at your school? E.g. Windows 11

13 | Which software application suite is used? E.g. Microsoft Office 2019

14 | Indicate with a tick v whether each of the following programs have
been properly installed on the computers in the examination centre.
Add the name of the software if not listed.
Word processor Spreadsheet Database
Notepad ++
Web [ ] Delphi browser Other

2010
15 | Have the latest updates/service packs been installed?

16 | Have the regional settings on the computers been set as follows?

16.1 | Region: South Africa

16.2 | Format: English (South Africa)
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| 16.3 | Language preferences:

Short date:  yyyy/MM/dd

Long date: dddd, dd MMMM yyyy
Short time: e.g. 10:01 AM

Long time: e.g. 10:01:11 AM

First day of week: Sunday

16.4 | Additional settings: Customise Format: Numbers Tab
. (full stop)
2 (two)

Decimal point symbol:

No. of digits after decimal point:

List separator: , (comma)

Measurement system: Metric

16.5 | Additional Settings > Customise Format > Currency Tab

Currency symbol: R

17

Has the units of measurement in the word processing application

been set to centimetres?
18 | Has the Developer Tab in the word processing application been N
activated?
I—19 Has the Ruler in the word processing application been activated?
| 20 | Have computers been set to save at 5-minute intervals for every
application?
21 Have accessories such as Paint been installed to be available to the
candidates?
| 22 | Which anti-virus program has been installed?
| 23 | At what intervals is the anti-virus program updated? _
24 | Have printer drivers been installed on each computer used for the
CAT examination? (It is necessary to install and test printers on each
computer, even though printing may not take place.)
25 | Have printers been installed for printing during the IT examination?
26 | Has the Recycle Bin on every computer been emptied/Will it be

emptied one day before the examination?
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27 | Is there a plan in place for emptying the Recycle Bin on every
computer before the 2" sitting?

28 | Has every computer been cleared of all other files/folders/documents
not needed for the examination? (The work of other classes must be
isolated.)

9 Has the school installed CD/DVD writers/arranged for access to
external CD/DVD writers?

30 [ Has the feature to use flash/memory disks been disabled on all
computers for the duration of the practical examination?

31 Will access to the internet be blocked/disabled for the duration
of the practical examination?

32 | What option will be used to transfer the candidates’ work to the final
DVD/CD to be submitted for marking? E.g. flash/memory disk;
network.

33 | Are there security systems in place to prevent the computers from
being stolen or accessed?

34 Does the school have a maintenance plan/budget in place for the

computer centre?
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CERTIFICATION (State of Examination Readiness) - continued

COMPUTER APPLICATIONS TECHNOLOGY AND INFORMATION TECHNOLOGY — NATIONAL
SENIOR CERTIFICATE: NOVEMBER 2024

All items on ANNEXURE A have been checked.

'Centres must ensure that all items on this checklist are revisited and are in place TWO days
before the examination)

CAT TEACHER IT TEACHER
NAME
NAME
DATE
DATE
SIGNATURE
SIGNATURE
SCHOOL PRINCIPAL IT TECHNICIAN
NAME NAME
DATE SIGNATURE DATE SIGNATURE

School stamp
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